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ABSTRACT 

 

Evaluation of motion characteristics of ships and offshore structures at the early 

stage of design as well as during operation at the site is very important. Strip theory 

based programs and 3D panel method based programs are the most popular tools used in 

industry for vessel motion analysis. These programs use different variations of the 

Green’s function or Rankine sources to formulate the boundary element problem which 

solves the water wave radiation and diffraction problem in the frequency domain or the 

time domain.  

This study presents the development of a 3D frequency domain Green’s function 

method in infinite water depth for predicting hydrodynamic coefficients, wave induced 

forces and motions. The complete theory and its numerical implementation are discussed 

in detail. An in house application has been developed to verify the numerical 

implementation and facilitate further development of the program towards higher order 

methods, inclusion of forward speed effects, finite depth Green function, hydro 

elasticity, etc. The results were successfully compared and validated with analytical 

results where available and the industry standard computer program WAMIT v7.04 for 

simple structures such as floating hemisphere, cylinder and box barge as well as 

complex structures such as ship, spar and a tension leg platform.  
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1  INTRODUCTION  

 

1.1 Motivation 

Potential-flow methods are widely used in marine hydrodynamics to calculate the 

forces and corresponding motion responses of floating bodies due to ocean waves. The 

2D-Strip theory based methods has been the most commonly used approach for solving 

motions and loads of slender bodies in waves, e.g. ships (McTaggart (1997)). With the 

increasing computational power, three dimensional boundary element methods became 

feasible. These methods remove the requirement of slenderness of the body which make 

them useful in the hydrodynamic analysis of offshore structures. Recently 

Computational Fluid Dynamics (CFD) approaches have provided hydrodynamic analysis 

of floating structures in a fully non-linear wave environment possible. However, long 

duration CFD simulation in the time domain is still unrealistic due to computational 

limitations. Potential flow methods give us the means to simulate floating structure 

behavior accurately for long duration predictions such as motion, loads and even 

maneuvering and slamming analysis.  

The purpose of this work is to develop an in house capability to compute three 

dimensional hydrodynamic coefficients in the frequency domain using the infinite depth 

Green’s function for zero speed. This has then been extended to convert the frequency 

domain hydrodynamic coefficients from time domain impulse response functions.  
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This effort gives us a platform which can be used to further improve on the 

capability of potential flow methods such as the effect of forward speed or performing 

higher order drift force calculations, etc. 

1.2 Background 

The computational methods for calculation of wave loads on floating bodies have 

been developed over many decades. At first ships were modeled in potential flow using 

linear strip theory which enabled us to predict the wave loads with reasonable accuracy. 

However, at a low frequency of encounter, or for full form ships such as tankers, or ships 

with large Froude Numbers, the result obtained using strip theory were not very 

satisfactory.  

For high sea states, nonlinear effects become important which can be considered 

in nonlinear strip theory methods where the instantaneous immersion of section shapes 

are used to obtain the wave loads. 

With the increase in computer power, it became possible to develop three 

dimensional methods to obtain wave loads. Of these, the boundary element method or 

panel method has become most popular. Panel methods solve the Laplace equation in the 

fluid domain by distributing sources and dipoles on the body and in some cases on the 

free surface. These surfaces are divided into triangular or quadrilateral panels with a 

constant or linearly varying source or dipole with unknown strength. The boundary 

condition is then applied which is often linearized for simplicity to solve for these 

unknown strengths. Green’s theorem relates the source and dipole distribution strength 
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to the potential and normal velocity on each panel. Once the potential is obtained we can 

obtain the velocity and pressure at any point in the fluid domain. The wave forces are 

found by integrating pressure over the submerged body surface and then applying 

Newton’s law to determine the motions. 

The three dimensional methods developed so far can be categorized in two 

groups: Green’s Function Methods and Rankine Source Methods.  

1.2.1 Green’s Function Methods 

The Green’s function method determines the velocity potential by distributing 

sources over the hull surface only. There is no need to discretize and distribute sources 

over the fluid free surface in this method. The Green’s function satisfies the continuity 

condition and all other boundary conditions including the free surface and radiation 

conditions but not the body surface boundary condition. LAMP (Lin, Shin, Chung, 

Zhang and Salvesen (1997)) and WAMIT (Lee and Newman (2005)) are example 

applications which use this approach. 

1.2.2 Rankine Source Methods 

The Rankine source methods have been used both in the frequency-domain and 

in the time domain. In the frequency domain, the velocity potential is determined by 

distributing Rankine or simple sources (1 / )r  over the body. Since the Rankine source 

does not satisfy the free surface condition, a source distribution on the free surface is 

needed as well,( Nakos, Kring and Sclavounos (1994)). 
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1.3 Literature Survey  

Theoretical development of potential theory started as early as 1950 when John 

(1950) obtained the infinitesimal motion of fluid in presence of an obstacle. Three 

dimensional methods came to existence when Hess and Smith (1964) first introduced 

flow calculation about arbitrary, non-lifting, three dimensional bodies using Rankine 

source. Later they Hess and Wilcox (1969) extended this theory to include presence of 

free surface with a small oscillating body. The theory of wave diffraction and scattering 

is described by Wehausen (1971) to formulate potential flow method for solving motions 

of floating bodies. Webster (1975) suggested another modification to Hess & Smiths 

method by discretizing the body surface using triangular panels instead of quadrilaterals. 

The use of Green’s function to represent the source potential in calculating wave loads 

on large floating bodies is given by Garrison (1978) and Garrison (1984). Two other 

numerical techniques called the integral-equation method and the hybrid-element 

method were compared by Mei (1978). Sclavounos and Lee (1985) discuss various 

topics on boundary element methods such as the properties of spectral techniques and 

the removal of irregular frequencies. They also show that the hydrodynamic forces 

predicted by the distribution of source is identical to the force calculated from the direct 

solution of velocity potentials. The panel method based program is then optimized for 

large number of panels with controlled accuracy by Newman (1986) and Newman and 

Sclavounos (1988). Many researchers including Faltinsen (1990) ,Newman (1992), Lee 

and Newman (2005) presented comprehensive reviews of the panel method for deep 

water applications. 
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The numerical implementation of the panel method is also well described by 

McTaggart (2002) and Islam, Islam and Baree (2009). Lin and Liao (2011) attempted a 

Fast Multiple Boundary Element Method (FEBEM) to solve the wave radiation problem 

for simple structures. 

The efficient evaluation of Green’s function and its derivatives are of significant 

importance in implementing boundary element methods. The computing time involved 

in the boundary-integral-equation methods almost varies linearly with the computing 

time required for evaluating the Green’s function and its derivatives. The numerical 

evaluation of Green function was explained in Newman (1984), Ponizy and Noblesse 

(1994) and Telste and Noblesse (1986). Bingham (1998) and Ponizy, Guilbaud and Ba 

(1998) also presented an analytical form of the Green function. Ohkusu and Iwashita 

(1989) numerically integrated the analytical form of Green function to solve the 

radiation diffraction problem for ships with forward speed. A comparison of classical 

and simple free surface Green’s function is presented in Yang and Lohner (2004). A 

multipole expansion of the Green’s function for fast numerical evaluation is developed 

and tested by Borgarino, Babarit, Ferrant, Spinneken, Swan et al. (2011).  

Higher order methods have been developed to increase accuracy of the force 

prediction. Zhu (1997), Rahman (1984) and Rahman (1998) gave a detailed description 

of such methods. Kouh and Suen (2001); Willis, Peraire and White (2006); Hong, Nam, 

Kim, Kim, Hong et al. (2011) are other examples of higher order implementations of 

panel methods. 
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The motion of floating bodies in the time domain can be obtained by 

transforming the frequency domain results. McTaggart (2003) presents the 

transformation techniques. 3D Time domain Green function has been also developed by 

Liapis (1986) and Beck and Liapis (1987). Liu, Teng, Gou and Sun (2011) replaced the 

convolution of the time domain Green function with their Fourier transformations and 

showed good agreement with published results.  

1.4 Description of the Present Work 

A 3D frequency domain panel method program is developed based on infinite 

water depth zero speed Green’s function. An open source project named APAME 3d 

panel method developed by Filkovic (2008) for analyzing airfoil at subsonic speed was 

studied in detail to understand paneling of the vessel hull. The numerical technique 

developed by Telste and Noblesse (1986) for numerically calculating the Green’s 

function is used for implementing free surface effects. Formulation of the hydrodynamic 

problem and numerical solution is then developed based on the overall approach 

suggested by McTaggart (2002).  

The application developed is then tested methodically for fully submerged and 

then floating bodies for a range of frequencies. Many structures ranging from simple 

hemisphere, cylinder and box barge to complex hull forms including TLP, USN LMSR 

ship and DWSC spar has been analyzed.  

The results were compared to analytical results where available and the well 

proven commercial program WAMIT v7.0 and found to be in excellent agreement.  
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2  MATHEMATICAL MODEL 

 

The hydrodynamic forces acting on the floating structure is solved using 

potential theory. The coordinate system is defined as explained in McTaggart (2002) 

with its origin in the still water plane aligned vertically with ship center of gravity and 

center line (see Fig. 1).  The wave heading angle is defined as shown in Fig. 2 where 

zero degree corresponds to the following sea. 

 

 

Fig. 1. Coordinate system (As used in McTaggart (2002)) 
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Fig. 2. Sea direction (As used in McTaggart (2002)) 

 

 

2.1 Governing Equations 

Assuming the fluid to be irrotational, a velocity potential may be defined as: 

 ,( , , , ) , ,

T

wheq x y z ret
x y z

   
     

   

  (2.1) 

where q  denotes the velocity vector of the fluid and   denotes the velocity potential. 

The total oscillatory velocity potential in the vicinity of a floating body in waves is 

broken into components as follows: 
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   (2.2) 

where   is total velocity potential, x  is location, t  is time, 
I

  is incident wave velocity 

potential,  is the angle of incident waves with respect to positive x  axis, 
D

   is 
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diffracted wave velocity potential,
j

  is the complex motion amplitude for mode j ,
j

 is 

radiation potential for mode j , and   is the incident wave frequency. 

The velocity potential satisfies the Laplace equation in the fluid domain 

 2
0    (2.3) 

The boundary conditions to be satisfied by the potential function are: 

1. The linearized combined kinematic and dynamic free surface boundary condition: 

 
2

0 0on z
z g

 



  


  (2.4) 

2. The sea bottom boundary condition for infinite depth: 

 0 on z
z


  


  (2.5) 

3. The body surface boundary condition: 

 0 ( , , )
n

v on S x y z
n


 


  (2.6) 

where 
n

v denotes the specified complex function which represents the magnitude of 

normal component of velocity on the immersed surface given by [ ( , , ) ]
i t

n n
V Re v x y z e


 . 

2.2 The Solution of Velocity Potentials Using Source Distribution 

The potential at some point ( , , )x y z in the fluid region may be expressed in terms 

of a surface distribution of sources. 

 
1

( ) ( ) ( ; )
4

s s

S

x x G x x dS 


    (2.7) 



 

10 

 

where 
s

(x )  denotes a point on the surface of the body S  , and ( )
s

x   denotes the 

unknown source distribution. The integral is to be carried out over the complete 

immersed surface of the object. The Greens function satisfies the continuity condition 

and all boundary conditions including the free surface and radiation boundary 

conditions, with the exception of the following normal velocity boundary condition on 

the hull surface: 

 
n

v on S
n





  (2.8) 

where 
n

v (x,y,z)  is the flow normal velocity on the hull surface. The evaluation of 

Greens function will be discussed in detail in later sections. The source strengths are 

solved such that following equation is satisfied: 

 
( , )1 1

( ) ( ) ( )
2 4

s

s n

S

G x x
x x dS v x on S

n
 




  


   (2.9) 

where /G n   denotes the derivative of the Green's function in the outward normal 

direction. This derivative of G  may be evaluated from: 

 
x y z

G G G G
n n n

n x y z

   
  

   
  (2.10) 

The oscillatory potential components ( 1, 2...6)
k

k   must satisfy the free-surface 

condition and the condition that the fluid on the hull surface must move identically to the 

hull surface. 

 
( )

k

k

x
i n

n








  (2.11) 

For solution of the wave diffraction potentials, the hull boundary condition is: 
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( ) ( )

D I
x x

n n

  
 

 
  (2.12) 

2.3 Numerical Solution 

The integral Equation (2.9) may be solved numerically by dividing the immersed 

surface S  into N  quadrilateral panels of area ( 1, 2, )
j

S j N    and solving the 

equation at the control point which are at the center of each panel. The discretized form 

of the Equation (2.9) gives N equations, as given in Garrison (1978). 

 
1 1

( ) ( , )
2 4 ii s i s n

S

G
x x x dS v

n
 




  


   (2.13) 

Furthermore, the surface integral in Equation (2.13) may be written as the sum of 

the integrals over the N  panels of area 
j

S  and, as an approximation, the source 

strength function ( , , )
s s s

x y z  may be taken as constant over each panel so that Equation 

(2.13)  becomes, 

 
1

1 1
1, 2,

2 2 i

N

i ij j n
j

v i N  


       (2.14) 

where 

 
( , )1

2
j

s

ij

S

G x x
dS

n









   (2.15) 

In physical terms, 
ij

  denotes the velocity induced at the th
i  node point in the 

direction normal to the surface by a source distribution of unit strength distributed 

uniformly over the th
j  panel. 
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In Equation (2.13) the function 
n

v  is considered specified and the elements of 

the    matrix are defined through the Green's function according to Equation(2.15). The 

unknown source strength 
i

  may, therefore, be obtained through the following equation: 

 1
[ ] 2[ ] [ ]

n
I v 


    (2.16) 

where I  denotes the unit matrix. Once the inverse of [ ]I   matrix is evaluated the 

vector   corresponding to several different 
n

v  vectors may be computed with very little 

computing time. Most computing time is used in evaluating the   matrix and the 

inversion of[ ]I  . 

Using the same numerical scheme as outlined above, Equation (2.7) may be 

expressed as the sum 

 
1

N

i ij j
j

  


    (2.17) 

in which 

 
1

( , )
4

j

ij i s

S

G x x dS




    (2.18) 

Hence, the numerical solution of the surface singularity distribution problem may 

be expressed as shown in Fig. 3. 



 

13 

 

 

Fig. 3. Steps of obtaining source strength 

 

2.4 Paneling of the Ship Hull 

The solution of the three-dimensional velocity potential for a ship hull requires 

that the hull geometry be modeled using panels. In this work the hull of the structure is 

divided into quadrilaterals and triangles where triangles are nothing but quadrilateral 

with two common vertices. The structure can be modeled in any design software like 

Rhinoceros (McNeel and Associates (2003)) or Solid Works (Planchard and Planchard 



 

14 

 

(2010)). Panelization is done through the meshing program available in most design 

packages. The mesh created needs to be exported as a GDF file which contains the 

coordinates of the panel vertices to be used in this program. 

The Coordinate of four vertices are 
1 1 1

A(x ,y ,z ) ,
2 2 2

B(x ,y ,z ) ,
3 3 3

C(x ,y ,z ) and 

4 4 4
D (x ,y ,z )  

Two diagonals of the quadrilateral are calculated as: 

 
1 3 1 3 1 3 1

2 4 2 4 2 4 2

ˆˆ ˆ( ) ( ) ( ) ( )

ˆˆ ˆ( ) ( ) ( ) ( )

D C A x x i y y j z z k

D D B x x i y y j z z k

       

       

  (2.19) 

The normal to the panel surface is calculated using vector multiplication of the 

two diagonal vectors: 

 
1 2

N D D    (2.20) 

hence the unit normal to the panel surface is 

 
1 2 3

ˆˆ ˆ

| |

N
n n i n j n k

N
      (2.21) 

Two lengthwise vectors (tangent to the panel surface) are calculated to form the 

local coordinate system as: 

 ˆˆ ˆ
x y z

L l i l j l k     (2.22) 

where, 

 

4 3 1 2

4 3 1 2

4 3 1 2

( ) ( )

2 2

( ) ( )

2 2

( ) ( )

2 2

x

y

z

x x x x
l

y y y y
l

z z z z
l

 
 

 
 

 
 

  (2.23) 
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and the unit vector is formed as 

 
1 2 3

ˆˆ ˆl l i l j l k     (2.24) 

 
1 2 3

,,
yx z

ll l
l l l

L L L
     (2.25) 

The other lengthwise vector is perpendicular to the normal and the lengthwise 

vector as calculated above: 

 P n l    (2.26) 

 
1 2 3

ˆˆ ˆ

| |

P
p p i p j p k

P
      (2.27) 

The centroid of the panel is calculated by: 

 

1 1 2 2 3 3 4 4

1 2 3 4

1 1 2 2 3 3 4 4

1 2 3 4

1 1 2 2 3 3 4 4

1 2 3 4

x

y

z

cx d cx d cx d cx d
c

d d d d

cy d cy d cy d cy d
c

d d d d

cz d cz d cz d cz d
c

d d d d

  


  

  


  

  


  

  (2.28) 

where, 

 

     

     

     

     

2 2 2

1 2 1 2 1 2 1

2 2 2

2 3 2 3 2 3 2

2 2 2

3 4 3 4 3 4 3

2 2 2

4 1 4 1 4 1 4

d x x y y z z

d x x y y z z

d x x y y z z

d x x y y z z

     

     

     

     

  (2.29) 

and 
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2 3 3 41 2 4 1

1 2 3 4

2 3 3 41 2 4 1

1 2 3 4

2 3 3 41 2 4 1

1 2 3 4

( ) ( )( ) ( )
, , , ,

2 2 2 2

( ) ( )( ) ( )
, , ,

2 2 2 2

( ) ( )( ) ( )
, , ,

2 2 2 2

x x x xx x x x
cx cx cx cx

y y y yy y y y
cy cy cy cy

z z z zz z z z
cz cz cz cz

  
   

  
   

  
   

  (2.30) 

The panel coordinates  ( , , ), 1 4
i i i

x y z i   are transformed from the body 

coordinate system ˆˆ ˆ( , , )i j k  to a local coordinate system ˆ ˆ ˆ( , , )l p n which lies in the panel 

surface plane to  ( , , 0), 1 4
i i

xl yl i    using 

 

1 2 3

1 2 3

( ) ( ) ( )

( ) ( ) ( )

1 4

li i x i y i

li i x i y i

x x c l y c l z cz l

y x c p y c p z cz p

i

     

     

 

  (2.31) 

The source is placed at a point called collocation point which is just below the 

centroid of the panel lowered by a parameter entered in the configuration file called

C O L L D IST .  

 

1

2

3

·

·

·

colx cx C O LLD IST n

coly cy C O LLD IST n

colz cz C O LLD IST n

 

 

 

  (2.32) 

The coordinate of the field point or the center of th
i (influenced) panel is 

calculated in the above local coordinate system which is in the plane of th
j  (influencing) 

panel is: 

 

1 2 3

1 2 3

1 2 3

· · ·

· · ·

· · ·

x y z

x y z

x y z

cpx dist l dist l dist l

cpy dist p dist p dist p

cpz dist n dist n dist n

  

  

  

  (2.33) 

where 
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( ) ( )

( ) ( )

( ) ( )

x

y

z

dist colx j cx i

dist coly j cy i

dist colz j cz i

 

 

 

  (2.34) 

2.5 Hydrostatics 

Hull hydrostatic properties can be computed from the panel properties as given in 

McTaggart (2002). The volume of a paneled hull is determined by the following 

discretized equation: 

 
1

pN

j z j j
j

A n z




     (2.35) 

where 
p

N  is the total number of panels, 
j

A  is the area of panel j , 
j z

n


 is the z normal 

component of the panel j , and 
j

z  is the z value (relative to the waterline) of the 

centroid of panel j . The location of the center of buoyancy relative to the waterline is: 

 2

1

1

2

pN

CB j z j j
j

z A n z




     (2.36) 

The longitudinal center of buoyancy, which corresponds with the longitudinal 

center of gravity, is given by: 

 
1

pN

CB j z j j j
j

x A n z x




     (2.37) 

where 
j

x  is the x value of the centroid of panel j . The hull water plane area, which is 

used for computing heave stiffness, is given by: 

 
1

pN

wp j z j
j

A A n




    (2.38) 
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The longitudinal centroid of floatation is given by: 

 
1

pN

wp wp j z j j
j

x A A n x




    (2.39) 

Water plane moment terms are: 

 2

1

pN

wp xx j z j j
j

I A n x
 



    (2.40) 

 2

1

pN

wp yy j z j j
j

I A n y
 



    (2.41) 

Using the above computed values, hydrostatic stiffness terms for motion 

equations are: 

 

33

35

44

53 35

55

w p

w p w p

C B C G w p yy

C B C G w p xx

C gA

C gA x

C g z z I

C C

C g z z I















 

     
 



     
 

  (2.42) 

where 
C G

z is the vertical center of gravity obtained from the input parameter V C G . 

2.6 Derivation of 3D Green’s Function 

The deep water Green’s function used in eqn. (2.7) has been derived in detail by 

Kim (2008). The derivation is repeated here for reader’s convenience with the coordinate 

system followed in rest of the thesis.  
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The potential flow due to a 3-D pulsating source at a fixed source point 

0 0 0
( , , )x y z  in the deep water bounded by free surface

F
S , bottom surface

B
S , and far 

field cylindrical surface S


  will produce 3-D progressing wave.  

Let the 3-D source potential be written as: 

  0 0 0 1 2
( , , ; , , ; ) Re

i t
x y z x y z t i e


 


   
 

  (2.43) 

Which satisfies the continuity and boundary conditions as described below: 

Continuity: 2
0, , 0

i
x z          (2.44) 

Free Surface: 
2

0, 0 ,
i

i F
z or on S

z g

 
 


   


  (2.45) 

Bottom: 0 ,
i

B
z or on S

z


  


  (2.46) 

Radiation: 1

2
lim 0,
R

R on S
R







 
  

 
  (2.47) 

where,    
2 2

0 0
R x x y y       

Since the sum of 3-D simple source 1 / r  and 3-D simple sink 1 / 'r  does not satisfy the 

standing wave flow near the free surface, a third potential G  that is harmonic in the 

lower half domain is added: 

  1 0 0 0

1 1
, , ; , ;

4 '

Q
G x y z x y z

r r




 
   

 
  (2.48) 

where, 

 
     

     

2 2 2

0 0 0

2 2 2

0 0 0
'

r x x y y z z

r x x y y z z

     

     

  (2.49) 
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2.6.1 The Free Surface Condition 

Substituting 
1

  into the free surface condition given in eqn. (2.45) gives: 

 

   
2 2 2

0
0 0 0

1
, 0

2

G Q
G z

z z x x y y z




 
  

     

  (2.50) 

since, 

 

   
2 2 2

0
0 0 0

1 1 1
2 , 0

'
z

z r r z x x y y z

   
   

      

  (2.51) 

and using the Hankel transform of the exponential function as given in Abramowitz and 

Stegun (1972): 

  
 

0
2 2

0

1
, 0

kb
e J ka dk b

a b



 


   (2.52) 

We substitute    
2 2

0 0
a R x x y y      and 

0
b z  into eqn. (2.50) and use 

eqn. (2.51) to write: 

 
   0 0

0 0

0 0 0

, 0
2 2

kz kzG Q Q
G e J kR dk ke J kR dk z

z z


 

 
 

   
 

    (2.53) 

The harmonic function G  may be assumed in the form: 

  
 

 0

0

0
2

k z zQ
G F k e J kR dk






    (2.54) 

with unknown  F k  . Substituting in eqn. (2.53) yields: 

  
k

F k
k 




  (2.55) 
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Hence, inserting  F k  into eqn. (2.54), we determine the function G  : 

  
 0

0

0
2

k z zQ k
G PV e J kR dk

k 







   (2.56) 

Substituting G  in the eqn. (2.48) we get: 

  

  
 0

1 0

0

1 1

4 ' 2

k z zQ Q k
PV e J kR dk

r r k


  



 
   

 
   (2.57) 

Since 

 1
k

k k



 
 

 
  (2.58) 

We can write: 

 
 

 
 

 
 

 

 

 

 

0

0

0

0

0

1 0

0

0

0

0 0

0 0

0

0

1 1

4 ' 2

1 1
1

4 ' 2

1 1

4 ' 2 2

1 1 1

4 ' 2 ' 2

k z z

k z z

k z z

k z z

k z z

Q Q k
PV e J kR dk

r r k

Q Q
PV e J kR dk

r r k

Q Q Q e
PV e J kR dk PV J kR dk

r r k

Q Q Q e
PV J kR

r r r k


  



  



   



   









  



 

 
   

 

   
      

   

 
    

 

 
    

 





 



 

 
0

0

0

1 1

4 ' 2

k z z

dk

Q Q e
PV J kR dk

r r k



  

 

 
   

 


  (2.59) 

2.6.2 Radiation Condition 

The remaining condition to be satisfied by both 
1

  and 
2

  is the prescribed 

radiation condition: 
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 1

2
lim 0,
R

R on S
R







 
  

 
  (2.60) 

Since,  1 / 1 / 'r r  of 
1

  vanish in the far field, the remaining task is to 

investigate the asymptotic expression of the Cauchy PV integral. 

We know, the first kind of Hankel function is defined as: 

  
 

 
 

 
 

1 1 1

0 0 0
H kR J kR iY kR    (2.61) 

Therefore, we consider the integral equation: 

 
 

 
 

0

1

0

0

R e

k z z
e

I PV H kR dk
k 

  
  

 
   (2.62) 

 

 

Fig. 4. K-plane 
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The closed contour integral along 
1 2 3
, ,C C C  and 

4
C  in the complex k-domain 

vanishes according to Cauchy theorem as shown in Fig. 4. Further the integration along 

3
C  and 

4
C  vanish for the large radius R    , whereas the integral along  2

i
C k e


  

yields a residue at k   , i.e., 

  
   

 0 1

0
Re |

z z

R
s k i e H R


  




     (2.63) 

Substituting in eqn. (2.62) gives: 

 

 
 
 

   
 

 
 

0

0

0

1

0

0

1

0

0

R e

R e |

|

k z z

z z

R

z z

R

e
I PV H kR dk

k

i e H kR

e Y kR











 



 



 

 
  

 

 
 

 



  (2.64) 

Thus the asymptotic expression of 
1

  becomes: 

 

 
 

 

0

0

1 0
| |

2

1
sin

2 4

z z

R R

z z

Q
e Y R

Q e R O
R R






 

 






 



 

   
      

   

  (2.65) 

According to the radiation condition, we can write the potential 
2

  as: 

 1

2

1
|
R

R








 


  (2.66) 

 
 01

1
| cos

2 4

z z

R
Q e R O

R R R

  
 





 

    
      

    
  (2.67) 

Hence, 

 
 0

2

1
| cos

2 4

z z

R
Q e R O

R R

 
 





 

   
     

   
  (2.68) 
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Substituting 
1

  and 
2

  in eqn. (2.43) we get: 

 

 

 0

1 2
| cos sin |

1
sin

2 4

R R

z z

t t

Q e R t O
R R



   

 
 



 



  

   
       

   

  (2.69) 

This indicates progressive outgoing wave in the far-field. Thus the radiation 

condition has been satisfied. 

Since the asymptotic expression of 
2

  is similar to cosine function, the 
2

  is 

expressed in terms of First Kind Bessel function  0
J kR   

 
 

 0

2 0
2

z zQ
e J R


 


   (2.70) 

2.6.3 Resultant 3-D Source Potential 

The resultant 3-D source potential is given in the form: 

 

 

 

 
 

0

0

0

0

0

1 1
cos

4 ' 2

sin
2

k z z

z z

Q Q e
PV J kR dk t

r r k

Q
e J R t





  


 

 



   
     

   




  (2.71) 

If we replace 
4

Q


 by unity, the resultant potential becomes: 

 

 

 

 
 

0

0

0

0

0

1 1
2 cos

'

2 sin

k z z

z z

e
PV J kR dk t

r r k

e J R t


 


  

 



   
     

   




  (2.72) 
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2.6.4 3-D Green’s Function 

The pulsating source potential also represents the Green’s function if we omit the 

time factor. 

  0
Re ;

i t
G P P e


  
 

  (2.73) 

with, 

 
 

 

 

 
 

0

0

0 0

0

0

1 1
; 2

'

2

k z z

z z

e
G P P PV J kR dk

r r k

i e J R





 

 



  





  (2.74) 

According to Kim (2008) the Green’s function is the reciprocating engine for 

determining velocity potentials at all points on the body surface at all frequencies. 

Wehausen and Laitone (1960) also presented a Green’s function which considers the 

finite water depth and is used in many panel method codes which is useful for shallow 

water wave load predictions.   

An efficient method of numerical computation of the infinite water Green’s 

function is given by Telste and Noblesse (1986) which is described in next section. 

2.7 Numerical Solution of the Green's Function and Its Gradient 

Non dimensional coordinates x  are defined in terms of some reference length L  

characterizing the size of the wave-radiating/ diffracting body; thus /x X L where X is 

dimensional. The mean sea is taken as the lower half-space 0, 0
s

z z  . The Greens 

function 
s

G ( x , x )  is the “spatial component” of the velocity potential [ ( , ) ]
i t

s
Re G x x e
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corresponding to the flow at ( , , )x x y z  caused by a singularity at ( , , )
s s s s

x x y z . Here t  is 

time,  is the radian frequency of the waves. 

For brevity, the following non dimensional variables are defined: 

 
2
L

f
g


   (2.75) 

 2 2 1/ 2
[( ) ( ) ]

s s
x x y y       (2.76) 

 2 2 1/ 2
[ ( ) ]

s
r z z     (2.77) 

 2 2 1/ 2
[ ( ) ]

s
r z z      (2.78) 

 2 2 1/ 2
, ( ), ( )

s
h f f z z d h fr           (2.79) 

The Green function 
s

G(x ,x ) and its gradients can be expressed in the form  

 
0

1 1
( , , )

s
G G x x f

r r
  


  (2.80) 

  0 0 0
( , , ) 2 , ( )

s
G x x f f R h i J h e


   

 
  (2.81) 

Telste and Noblesse (1986) gives the following equations for the derivatives of 

the frequency dependent portion of the Green function: 

 
20

1 1
2 ( , ) ( )

vG
f R h v i J h e




   
 


  (2.82) 

 0 0
( )

s
G x x G

x  

  


 
  (2.83) 

 0 0
( )

s
G y y G

y  

  


 
  (2.84) 
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20

0 0

1
2 ( , ) ( )

vG
f R h v i J h e

z d


  
  

   
  (2.85) 

where 
0

J (h) and 
1

J (h) are the usual Bessel functions of the first kind, 
0
( , )R h  and 

1
( , )R h  are real functions to be defined. 

2.8 Numerical Integration over a Panel 

To evaluate the matrix   in Equation (2.15) and matrix   in Equation (2.18) 

also shown below, we need to integrate the Greens function and its derivatives over the 

panel surface. 

 
( , )1

2
j

s

ij

S

G x x
dS

n









   (2.86) 

 
1

( , )
4

j

ij i s

S

G x x dS




    (2.87) 

The Greens function is represented as: 

 
0

1 1
( , , )

s
G G x x f

r r
  


  (2.88) 

Hence, 

 0
1 1 1 1 1

2 2 2
j j j

ij

S S S

G
dS dS dS

n r n r n


  
  

    
     

     
     (2.89) 

 
0

1 1 1 1 1

4 4 4
j j j

ij

S S S

dS dS G dS
r r


  

  

  
     (2.90) 
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The frequency independent part of the Greens function is evaluated analytically 

using the method suggested by Hess and Smith (1964) to obtain 
ij

 and 
ij

 . To evaluate

ij
 , the following equations are used: 

 
1 1 1 1

j j j j

x y z

S S S S

dS n dS n dS n dS
n r x r y r z r

   

          
         

          
      (2.91) 

 

3 2 2 3 232 1 1 2 12

12 1 2 12 23 2 3 23

4 3 3 4 34 1 4 4 1 41

34 3 4 34 41 4 1 41

1

jS

y y r r dy y r r d
dS ln ln

x r d r r d d r r d

y y r r d y y r r d
ln ln

d r r d d r r d



         
     

         

        
    

     


  (2.92) 

 

2 3 2 3 231 2 1 2 12

12 1 2 12 23 2 3 23

3 4 3 4 34 4 1 4 1 41

34 3 4 34 41 4 1 41

1

jS

x x r r dx x r r d
dS ln ln

y r d r r d d r r d

x x r r d x x r r d
ln ln

d r r d d r r d



         
     

         

        
    

     


  (2.93) 

 

1 112 1 1 12 2 2

1 2

1 123 2 2 23 3 3

2 3

1 134 3 3 34 4 4

3 4

1 141 4 4 41 4 1

4 1

1

jS

m e h m e h
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  (2.94) 

ij
  is evaluated using the analytical expressions given in Katz and Plotkin 

(2001): 
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  (2.95) 

where, 

 

   

   

   

   

2 2
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  (2.96) 
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  (2.97) 

    
2 2 2

, 1, 2, 3, 4
k k k

r x x y y z k        (2.98) 

  
22
, 1, 2, 3, 4

k k
e z x x k      (2.99) 
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    , 1, 2, 3, 4
k k k

h y y x x k      (2.100) 

The values of the terms which would be infinity while implementing the above 

equation numerically were set to 0. This is achieved by checking the denominator to be 

greater than a small error parameter entered through input file (e.g. ERROR 0.0000001). 

The integration of frequency dependent term which is the wavy Green function   

(
0

G ) and its derivative ( 0
G

n




 ) can be done is multiple ways. For higher accuracy a 

Gauss Quadrature method may be applied. However, these terms are regular throughout 

the fluid domain and oscillate approximately with wave length L  . In practice L  is 

generally large compared to the dimension of the immersed panel surface, so 
0

G  and 

0
G

n




 vary slowly over S . Thus, a valid and convenient approximation to the integral is 

to evaluate the integrands at the centroid of the panel and multiply by 
j

S  .  

2.9 Radiation Velocity Potentials 

Radiation velocity potentials are obtained by solving the equation: 

 1
[ ] 2[ ] [ ]

n
I v 


    (2.101) 

where 
n

[v ]  is obtained by satisfying hull boundary condition for radiation 

 
( , , )

[ ]
k

n k

x y z
v i n

n





 


  (2.102) 

where 
k

n is the generalized unit normal defined as 

 
1 2 3

( , , )n n n n   (2.103) 
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4 5 6

( , , )n n n r n    (2.104) 

where 

n  unit normal pointing outward of hull surface 

1 2 3

ˆˆ ˆn i n j n k     

r   is a vector from the origin to a point on the hull surface 

ˆˆ ˆxi yj zk     

Radiation potential for each mode (i.e. surge, sway, heave, roll, pitch, yaw) is then 

calculated as 

 
1

N

i ij j
j

  


    (2.105) 

where 
j

  is obtained by substituting 
n

v  for that mode. 

2.10 Incident and Diffracted Wave Potentials 

The complex potential of a regular wave system for deep water is as follows: 

    I

iga
exp ik x cos y sin exp kz  


       (2.106) 

where a  is the incident wave amplitude, we will use 1a  for our calculations to obtain 

the RAOs. The above equation is based on the convention of the wave crest being at the 

xy origin at time 0t  . Fluid velocities are given by the following derivatives: 

    I a cos exp ik x cos y sin exp kz
x


   


    


  (2.107) 

    I a sin exp ik xcos y sin exp kz
y


   


    


  (2.108) 
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    I ia exp ik x cos y sin exp kz
z


  


    


  (2.109) 

The diffraction potential 
D

  is solved using 

 1
[ ] 2[ ] [ ]

n
I v 


    (2.110) 

where 
n

[v ]  is obtained by satisfying diffraction boundary condition: 

 
1

N

i ij j
j

  


    (2.111) 

where 
j

  is calculated by substituting 
n

v  obtained above. 

2.11 Linearized Pressure Force on the Body 

The total pressure in the fluid is given by Bernoulli's equation 

 .p gz
t


 

      
 

  (2.112) 

where 

 i t
e


    (2.113) 

The first term on the right side of Equation (2.112)  is the linear component of 

the dynamic pressure, which is written in the complex form as i . The second term 

is the quadratic pressure, which contributes to the second-order forces. The third term is 

the hydrostatic pressure, which contributes to the restoring forces. 

The linearized dynamic pressure on the immersed surface due to the six-degree 

of freedom motion of the body is given by: 

 p
t




 


  (2.114) 
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   , 1, 2, ..., 6
k k

p i k      (2.115) 

and the dynamic pressure due to wave interaction with the fixed hull is given as: 

  ( )
D I D

p i       (2.116) 

The total pressure is expressed as: 

 

6

1
I D j j

j

p i     


 
    

  

   (2.117) 

where 
j

 is the complex motion amplitude for the mode j . In our calculation we will set 

1
j

  . 

The forces and moments caused by the dynamic fluid pressure acting on the 

immersed surface on the body are determined from the below expressions as given in 

Garrison (1978): 

   , 1, 2, ..., 6
ij j i

S

F t P n dS i j     (2.118) 

 ( ) 1, 2, ..., 6
i D i

S

F t P n dS i     (2.119) 

where 
i

F  denotes the th
i component of wave excitation force or moment and 

ij
F  denotes 

the th
i  component of force or moment arising from th

j  component of body motion. The 

function 
i

n  are generalized normal vectors 
1 2 3

( , , )n n n n  and 
3 4 5

( , , )n n n r n   where 

n  is the normal to the body surface and r  is the position vector of the center of the body 

surface panel. 

 
 

   

1 2 3 4

5 6

, , ,

,

x y z z yx

x z y xy z

n n n n n n n r n yn zn

n r n zn xn n r n xn yn

      

       
  (2.120) 
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2.12 Added Mass and Damping Coefficients 

As given in Ship Motion Lecture notes: 

 ( )
jk j k

S

A n Im dS





     (2.121) 

 ( )
jk j k

S

B n Re dS      (2.122) 

Non-dimensional values are: 

 
ij

ij k

A
A

L
   (2.123) 

 
ij

ij k

B
B

L 
   (2.124) 

Here 

 

k=3 for (i,j=1,2,3) 

k=4 for (i=1,2,3, j=4,5,6), or,(i=4,5,6,  j=1,2,3)

k=5 for (i,j=4,5,6)

  (2.125) 

2.13 Exciting Forces 

The exciting forces due to wave body interaction is calculated using two methods 

as explained in Lee (1995). 

2.13.1 Total Exciting Forces from the Haskind Relations: 

 I

k k I k

S

X i n dS
n


  

 
   

 
   (2.126) 
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2.13.2 Exciting Forces from Direct Integration of Hydrodynamic Pressure: 

  k k I D

S

X i n dS       (2.127) 

 i

i m

X
X

gAL
   (2.128) 

where m =2  for i=1,2,3  and m =3 for i=4,5,6 . A  is the wave amplitude (1 in this case) 

and L  is the characteristic length parameter U LEN . 

2.14 Body Motion in Waves 

The oscillatory motion of a freely floating body with harmonic excitation and 

without external constraints can be obtained by solving the equation of motion: 

  
6

2

1
ij ij ij ij j i

j

M A i B C X  


     
 

   (2.129) 

where 

 m     (2.130) 

 
b g b g

x x y y   (2.131) 

 
11 12 13

21 22 23

31 32 33

0 0 0

0 0 0

0 0 0

0

0

0

g g

g g

g g

g g

g g

g g

m m z m y

m m z m x

m m y m x
M

m z m y I I I

m z m x I I I

m y m x I I I

 
 


 

 
  

 

 
 
 
 

  (2.132) 

 
ij ij ij

I r r    (2.133) 
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The array  ,XPRDCT I J which is obtained from user input file contains the 

radius of gyration 
ij

(r ) with the same units of length as the length scale U LEN defined in 

the panel data file. 
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3   INCORPORATING EFFECT OF FORWARD SHIP SPEED 

 

The effect of forward ship speed may be approximated for moderate vessel 

speeds by including encounter frequency. The method explained here follows the 

procedure outlined by McTaggart (2002). The setup up of the problem is similar to as 

explained in Section 2 with a few modified terms as shown below: 

3.1 Modifications in Governing Equations 

The total velocity potential in eqn. (2.2) may be modified as: 

 

6

1

( , , , ) Re ( , , ) ( , , ) ( , , ) ei t

I I D I j j e
j

x y z t x x x U e


        


   
     

    

   (3.1) 

The wave encounter frequency 
e

  is given by: 

 cos
e I I S

k U      (3.2) 

Wave number for radiated wave is given by: 

 
2

e

e
k

g


   (3.3) 

Neglecting second and higher order terms, the oscillatory pressure acting on the ship hull 

is given by: 

 
6

3

1

e I D j j

j

p i U g
x

       


  
       

   
   (3.4) 
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The last term of the above equation denotes the oscillatory pressure due to 

hydrostatic pressure, with 
3

  being the oscillatory vertical displacement: 

 
3 3 4 5

y x        (3.5) 

The oscillatory motion of the ship can be solved as follows: 

             2 I D

e e
M A i B C F F          

where  M  is the ship mass matrix,  A  is the added mass matrix,  B  is the radiation 

damping,  C  is the hydrostatic stiffness matrix,  I
F  is the incident wave force vector, 

and  D
F  is the wave diffraction force vector. The added mass and damping matrix 

terms are given by: 

  Im Re
k

jk k j

e eS

U
A n dS

x




 

  
    

  
   (3.6) 

  Re Im
k

jk k j

eS

U
B n dS

x


 



  
    

  
   (3.7) 

The wave excitation forces on the ship are given by: 

 
I I

j e I j

eS

U
F i n dS

x


 



 
  

 
   (3.8) 

 
D D

j e I j

eS

U
F i n dS

x


 



 
  

 
   (3.9) 

The solution of velocity potential using source distribution remains same except the 

radiation boundary condition in eqn. (2.11) which is modified as: 
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k

e k

x
i n

n








  (3.10) 

3.2 Radiation Velocity Potential for Non-Zero Forward Speed 

The velocity potentials for non-zero forward speed may be calculated efficiently 

from velocity potentials for zero forward speed. Beck and Loken (1989), Papanikolaou 

and Schellin (1992) and Salvesen, Tuck and Faltinsen (1970) used this method as well 

for velocity potential calculation. Once the velocity potential for zero speed is found, 

velocity potential at non-zero speed are given by: 
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  (3.11) 

Similarly, the x  derivatives of the forward speed potentials can be evaluated 

using the x  derivatives of the zero speed potentials. 

As mentioned before, the speed correction term used in above equations are 

approximate and are based on the assumption of /
e

U   being small. Care should be 

taken when using the above model for practical purposes. An upper limit for /
e

U  equal 

to / 2L  is suggested by McTaggart (2002). 
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More accurate but computationally intensive methods using frequency domain 

Green’s function which incorporates forward ship effect has been also developed. One of 

such implementation is presented in Inglis and Price (1981). Many such algorithms exist 

among which the Green’s function developed by Ba and Guilbaud (1995) is considered  

most efficient and most commonly used. 

 The selection of method for incorporating forward speed effect in the presented 

code here is under consideration and has not been implemented yet. The results 

presented in this thesis are evaluated for zero speed case only.  
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4  IRREGULAR FREQUENCY REMOVAL 

 

4.1 Definition of the Irregular Frequencies 

  The integral equation formulated using unknown source strengths in eqn. (2.9) 

is solved to obtain the potential at the centroid of body surface panels from which we 

calculate the flow velocity and pressure to obtain the wave force on the floating body. 

The Fredholm determinant of this integral equation vanishes at the irregular frequencies. 

It is shown by Ohmatsu (1975) that the irregular frequencies corresponds to the 

eigenfrequencies of the interior homogeneous Dirichlet problem. 

It is not possible to analytically determine the irregular frequencies for an 

arbitrary shaped body. However, for simple structures such as a truncated cylinder or a 

box barge it is possible to solve the Laplace equation with Dirichlet boundary condition 

to determine the location of the irregular frequencies. Example calculation for 

analytically determining the irregular frequencies is shown in Zhu (1994). 

4.1.1 Irregular Frequency of Truncated Circular Cylinder 

The irregular frequencies may be calculated analytically for truncated circular 

cylinder. Considering a cylinder of radius R and draft T, the velocity potential  x


 is 

may be represented as: 
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sinh cos

cosh sin
m

kz m
x J kr

kz m







   
    
   

  (4.1) 

where 0,1, 2, ...,m   and 
m

J  is the Bessel function of order m .  

Since   x


 satisfies the homogeneous Dirichlet condition on the cylinder 

bottom, the above equation becomes 

      
cos

sinh
sin

m

m
x k z T J kr

m







 
   

 

  (4.2) 

On applying the homogeneous Dirichlet condition on the surface of the cylinder, 

  0
m

J kR    defines a set of k ’s. These values of k  corresponds to the irregular 

frequencies.  

The infinite depth wavenumber K  is calculated using the relation obtained by 

applying the free surface condition: 

 cothK k kT   (4.3) 

The values calculated for a truncated floating cylinder of radius R=1 and draft 

T=1 using Fig. 5 is shown in Table 1. 
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Fig. 5. Irregular frequency of the truncated floating cylinder of radius R 
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Table 1: List of irregular frequencies 

k K ω ω√(L/g) 

2.4048 2.4443 4.8966 1.5634 

3.8317 3.8353 6.1336 1.9584 

5.1356 5.136 7.0978 2.2663 

5.5201 5.5203 7.3586 2.3495 

7.0156 7.0156 8.2956 2.6487 

8.4172 8.4172 9.0866 2.9012 

8.6537 8.6537 9.2133 2.9417 

10.1735 10.1735 9.9896 3.1896 

11.6198 11.6198 10.6762 3.4088 

11.7915 11.7915 10.7547 3.4339 

13.3237 13.3237 11.4321 3.6502 

14.796 14.796 12.0472 3.8466 

14.9309 14.9309 12.102 3.8641 

16.4706 16.4706 12.7107 4.0584 

17.9598 17.9598 13.2729 4.2379 

18.0711 18.0711 13.3139 4.251 

19.6159 19.6159 13.8713 4.429 

21.117 21.117 14.3923 4.5953 

21.2116 21.2116 14.4245 4.6056 

 

 

The effect of irregular frequency is shown in Fig. 6, Fig. 7, Fig. 8 and Fig. 9 in 

the numerically calculated added mass and damping plots. 
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Fig. 6. Irregular frequency at non dimensional frequency 1.96 shown in numerically 

calculated surge added mass (A11) 

 

 

 

Fig. 7. Irregular frequency at non dimensional frequency 1.96 shown in numerically 

calculated surge damping (B11) 
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Fig. 8. Irregular frequency at non dimensional frequency 1.56 and 2.27 shown in 

numerically calculated heave added mass (A33) 

 

 

 

Fig. 9. Irregular frequency at non dimensional frequency 1.56 and 2.27 shown in 

numerically calculated heave damping (B33) 
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4.1.2 Irregular Frequency of Box Barge 

The irregular frequency of a box barge of length L, breadth B and draft T may 

also be found analytically. Considering  x


 satisfying homogeneous Dirichlet 

condition on the bottom: 

    
1 2

1 2

cos cos
sin

sin sin

k x k y
x k z T

k x k y



   
     

   

  (4.4) 

  
1/ 2

2 2

1 2
k k k    (4.5) 

To satisfy the homogeneous Dirichlet boundary condition on the sides / 2x L   

and / 2y B   , the value of 
1

k  and 
2

k  must be: 

 
1

2

2

n

k
L n






 
 

  
 

 

  (4.6) 

 
2

2

2

m

k
B m






 
 

  
 

 

  (4.7) 

where  , 0,1,m n   .The above two equations and eqn. (4.5) gives a discrete set of 

irregular frequencies. 

The calculation for a box barge of L=80m, B=20m, T=10m is shown in Table 2 

and Table 3 with non dimensionalizing length equal to 40m. The irregular frequency of 

box barge is shown in Fig. 10, Fig. 11, Fig. 12, and Fig. 13. 
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Table 2: Values of k1 and k2 

n k1 m k2 

0 0 0.03927 0 0 0.15708 

1 0.07854 0.11781 1 0.314159 0.471239 

2 0.15708 0.19635 2 0.628319 0.785398 

3 0.235619 0.274889 3 0.942478 1.099557 

 

 

 

Table 3: Nondimensional irregular frequencies 

k1 k2 k K ω ω√(L/g) 

0.03927 0 0.03927 0.10508834 1.015294 2.050252 

0.03927 0.15708 0.161914 0.17513694 1.3107 2.646786 

0.03927 0.314159 0.316604 0.31773218 1.765408 3.565009 

0.03927 0.471239 0.472872 0.47294619 2.153875 4.349465 

0.03927 0.628319 0.629545 0.6295488 2.485017 5.018162 

0.03927 0.785398 0.786379 0.78637953 2.77735 5.608492 

0.03927 0.942478 0.943296 0.94329558 3.041855 6.142623 

0.03927 1.099557 1.100258 1.10025845 3.285201 6.634029 

0.07854 0 0.07854 0.1197629 1.083866 2.188725 

0.07854 0.15708 0.17562 0.18641818 1.352255 2.730701 

0.07854 0.314159 0.323828 0.3248263 1.785008 3.604588 

0.07854 0.471239 0.477739 0.47780676 2.164914 4.371758 

0.07854 0.628319 0.633208 0.63321225 2.492236 5.032742 

0.07854 0.785398 0.789315 0.78931561 2.78253 5.618952 

0.07854 0.942478 0.945745 0.94574464 3.045801 6.150592 

0.07854 1.099557 1.102359 1.10235885 3.288335 6.640358 

0.11781 0.15708 0.19635 0.20424235 1.415427 2.858268 

0.11781 0.314159 0.335522 0.33634065 1.81637 3.667919 

0.11781 0.471239 0.485742 0.4858006 2.182949 4.408177 

0.11781 0.628319 0.639268 0.63927137 2.504132 5.056763 

0.11781 0.785398 0.794185 0.79418494 2.7911 5.636257 

0.11781 0.942478 0.949812 0.94981237 3.052344 6.163805 

0.11781 1.099557 1.105851 1.10585066 3.293539 6.650867 
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Table 3: Continued 

0.15708 0.15708 0.222144 0.22743205 1.493621 3.01617 

0.15708 0.314159 0.351241 0.35186617 1.857819 3.751619 

0.15708 0.471239 0.496729 0.49677757 2.207474 4.457702 

0.15708 0.628319 0.647656 0.64765899 2.520506 5.089829 

0.15708 0.785398 0.800952 0.80095229 2.802966 5.66022 

0.15708 0.942478 0.955478 0.95547811 3.061434 6.182162 

0.15708 1.099557 1.110721 1.11072074 3.300783 6.665495 

 

 

 

 

Fig. 10. Irregular frequency at non dimensional frequency 3.02 shown in surge added 

mass (A11) of a box barge 
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Fig. 11. Irregular frequency at non dimensional frequency 3.02 shown in surge damping 

(B11) of a box barge 

 

 

 

 

Fig. 12. Irregular frequency at non dimensional frequency 2.64 shown in heave added 

mass (A33) of a box barge 
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Fig. 13. Irregular frequency at non dimensional frequency 2.64 shown in heave damping 

(B33) of a box barge 

 

 

 

4.2 Removal of Irregular Frequencies 

Many methods exist for irregular frequencies removal. A survey of such different 

methods may be found in Lau and Hearn (1989).  Zhu (1994) presented two methods to 

remove irregular frequencies including the results of their numerical implementation. 

The first method is developed using a modified Green’s function where it is argued that 

a source point placed at specific known locations at the free surface inside the body 

unless it’s at the nodal point can remove the irregular frequencies. This method is tested 

for structures with two planes of symmetry and found to be effective. However, for 

arbitrary shaped bodies it is not possible to find the location of nodal points.  This makes 

this method impractical for our purpose. 
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The second method is called “Extended Boundary Condition Method”. Since, the 

irregular frequencies corresponds to the eigenfrequencies of the interior Dirichlet 

problem as shown by Ohmatsu (1975), a rigid lid can be placed on the interior free 

surface of the body to suppress the internal sloshing modes. This method has been 

developed by Ohmatsu (1975) and Kleinman (1982).  

The numerical implementation of the second method is discussed in detail by 

Zhu (1994) including a method to generate the free surface lid automatically. It was 

found that the irregular frequency removal requires the number of panels on the lid to 

exceed a certain number below which the irregular frequencies are not completely 

removed. The additional panels on the lid increase the size of the linear equations to be 

solved which requires additional computational time. It was found that the number of 

panels required at the free surface lid reasonably small and the increase in computation 

time is acceptable. This method is found to be more efficient compared to other methods 

and will be implemented in MDL HydroD. However at this time the results presented in 

this report does not include irregular frequency removal. 
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5  MEAN DRIFT FORCES AND MOMENTS 

 

The boundary element method described in previous sections shows wave force 

and moment calculation of an arbitrarily shaped floating body using linear wave theory. 

The higher order terms were neglected in the previous calculations. The nonlinear terms, 

in some cases can be of significant importance. For example, the second order drift force 

and moment terms can be used to calculate the mean drift force and moment in an 

irregular sea. Although, these forces are small in magnitude compared to the linear wave 

forces, they may cause large excursions of a freely floating body, since without mooring 

the restoring force in horizontal plane is zero. 

An exact expression for the horizontal drift force and moment is presented in 

Newman (1967) which is modified by Faltinsen and Michelsen (1975) for finite depth 

and given as: 
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  (5.1) 

where the bars denote time average and the integration is over the surface S


 of a 

vertical circular cylinder of large radius r , that is extending from the free surface down 

to z h  . The x  and y  component of the drift force is represented as 
x

F  &
y

F  
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correspondingly and 
z

M  is the drift moment about z  axis. The cylindrical polar 

coordinate system  , ,r z  is used with cosx r   and siny  . 
r

V  andV


 are the 

radial and tangential velocity components, respectively, and p  is the dynamic pressure. 

The eqn. (5.1) is approximated and only the second order terms with respect to 

wave amplitude are kept. To do this, velocity potential of only first order with respect to 

wave amplitude is required.  
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Here  F   is real and  
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F e
 

  is given by: 
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Further,   
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Here 
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  is defined by 
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where, , 1 6
i

i   are the six modes of motion.   

Using Bernoulli’s equation we may write, 
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Here   is the free-surface elevation and V  the fluid velocity vector which has 

the components  , ,
r z

V V V


. It is found that 
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Here  
'

F   and  
'

   mean /dF d  and /d d  , respectively. By applying 

the method of stationary phase it has been calculated for large r: 
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where  g   is some arbitrary function. By using eqn. (5.6) to eqn. (5.11)  the drift 

forces and moment may be written as: 
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where  
'

   means /d d   evaluated at   .  

Numerical implementation of the above expressions to calculate the mean drift 

force for arbitrary shaped floating body required more study and will be considered as a 

future effort. 
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6  RESULTS AND DISCUSSION 

 

A number of cases have been analyzed to both verify and demonstrate the 

capability of the developed numerical code. Since the Green’s function is comprised of a 

Rankine source, image source and frequency dependent wavy part, we can verify the 

numerical implementation in stages. The panel setup and integration of the Rankine 

source over panel can be verified by analyzing deeply submerged bodies where the 

effect of the free surface is not present. Hence, the image source and the wavy part of the 

Green’s function will not have any effect for such cases. Added mass is calculated for a 

deeply submerged sphere and a cube and compared with the analytical results given by 

Sarpkaya and Isaacson (1981). 

6.1 Sphere 

The theoretical value of added mass of sphere (Fig. 14) is given by 32

3
r  . The 

  and r  are the density of water and the radius of sphere respectively. The comparison 

results are shown in Table 4. 
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Fig. 14. Deeply submerged sphere 

 

 

Table 4: Added mass of deeply submerged sphere 

 3
1025 /kg m    1r m   

Panel 

No 

Theoretical Added Mass Numerical Added Mass 

Surge Sway Heave Surge Sway Heave 

128 2146.75 2146.75 2146.75 2303.17 2303.17 2215.74 

2048 2206.77 2206.77 2192.41 
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6.2 Cube 

 

 

Fig. 15. Deeply submerged cube 

 

 

The theoretical value of the added mass of a deeply submerged cube (Fig. 15) is 

given by 3
0.7 a  . The   and r  are the density of water and the length of cube 

respectively. The comparison result is shown in Table 5. 

 

Table 5: Added mass of deeply submerged cube 

 3
1025 /kg m    1a m   

Panel 

No 

Theoretical Added Mass Numerical Added Mass 

Surge Sway Heave Surge Sway Heave 

864 717.50 717.50 717.50 665.37 665.37 665.34 
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As shown above, the analytical results and numerical results for added mass 

calculation agree with each other. The next step of verification is performed for the 

frequency dependent added mass calculation for a hemisphere with free surface. The 

results were found to compare well with the WAMIT results. 

6.3 Floating Hemisphere 

The simple floating hemisphere (Fig. 16) of dimension given in Table 6 is 

analyzed and the comparison results are presented in Fig. 17 and Fig. 18. 

 

 

Fig. 16. Floating hemisphere 

 

 

Table 6: Floating hemisphere 

Parameter Value 

Radius 1 m 

Number of Panels 1152 

Water Depth Infinite 

Non dimensionalizing length (L)  1m 
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Fig. 17. Comparison of surge added mass of a floating hemisphere 

 

 

 

Fig. 18. Comparison of heave added mass of a floating hemisphere 

 



 

63 

 

Once the effect of free surface is incorporated successfully, a number of 

structures ranging from simple structures such as a truncated cylinder to complex 

structures such as TLP is analyzed and compared with WAMIT results. See APPENDIX 

III for more detailed results.  

The results are shown to break down at some certain frequencies. These 

frequencies are called irregular frequencies which can be removed using numerical 

techniques as described in earlier sections.  

The developed program is used to analyze the motion characteristics of a US 

Navy Large Medium Speed Roll-on/roll-off vessel the USN Bob Hope. The Response 

Amplitude Operator calculated from MDL HydroD and WAMIT were compared and 

shown below. 

6.4 USN LMSR Ship (Bob Hope) 

The US Navy Large Medium Speed Roll on-Roll off vessel Bob Hope (Fig. 19) 

is also analyzed and compared with WAMIT results.  Vessel parameters are given in 

Table 7. 
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6.4.1 Geometry and Panel Details 

 

 

Fig. 19. Panel model of Bob Hope 

 

 

 

Table 7: USN LMSR Bob Hope dimension and panel details 

Parameter Value 

Length Between Perpendicular, Lpp 269.45 m 

Breadth molded on waterline, B 32.258m 

Draft, T 8.795 m 

Number of Panels 1416 

Water Depth Infinite 

Non dimensionalizing length 135 m 
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6.4.2 Hydrostatics 

The hydrostatic result comparison is listed in Table 8. 

 

 

Table 8: Hydrostatics result comparison 

Parameter MDLHydroD WAMIT 

Volume VOLX = 49017.17 

VOLY=  48950.77 

VOLZ = 49029.09 

VOLX = 49012.4 

VOLY= 48951.0 

VOLZ = 49033.7 

Center of Buoyancy Xb= -9.4776773 

Yb= 0.00000 

Zb= -3.897359 

Xb= -9.485846 

Yb= 0.00000 

Zb= -3.898955 

Hydrostatic Stiffness Terms C33 = 0.3918698 

C35 =   4.2208418E-02 

C44 =    6.0625182E-04 

C55 =  0.1000643 

C33 = 0.39187 

C35 =   4.2221E-02 

C44 =   6.0621E-04 

C55 =  0.10002 

 

 

6.4.3 RAO 

The vessel RAO comparison is shown in Fig. 20, Fig. 21, and Fig. 22. 

 



 

66 

 

 

Fig. 20. Surge RAO of USN LMSR Bob Hope 

 

 

 

Fig. 21. Heave RAO of USN LMSR Bob Hope 
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Fig. 22. Pitch RAO of USN LMSR Bob Hope 
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7  CONCLUSIONS 

 

The objective of the present work has been to develop a computer software 

system to predict hydrodynamic coefficients, wave loads and motion of floating bodies 

in deep water. From a survey of available theoretical formulations and numerical codes, 

the zero speed infinite depth Green function based method has been selected as a starting 

point and an efficient analysis tool has been developed.  

The current implementation includes hydrostatics, frequency domain added 

mass, radiation wave damping, wave excitation calculated using diffraction potential and 

using the Haskind relation, Froude Krylov forces and vessel response amplitude 

operator. A module has also developed to obtain the time domain coefficients from 

frequency domain. 

A number of models have been tested to verify and validate the numerical 

implementation. The results were compared with analytical results and the industry 

standard seakeeping application WAMIT and found to show good agreement.  

Further development of the program to include irregular frequency removal, 

mean drift calculation and forward speed effect are ongoing. 
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APPENDIX I  

PROGRAMMING DETAILS 

 

1 Language 

The numerical implementation of velocity potential and hydrodynamic force 

calculation is done using Fortran 90 language. Fortran 90 is extensively used in 

computationally intensive areas of scientific computing and it is one of the most popular 

languages in high-performance computing. This program is developed with the intension 

of future development of larger applications which will use this as a sub module and 

benefits from its faster response time.  

2 Compiler and IDE 

The program is developed and tested in both Windows and UNIX environment. 

In Windows, Microsoft Visual Studio 2008 is used as IDE and Intel Visual Fortran with 

Intel Math Kernel Library which comes in a bundle as Intel Composer XE is used. The 

program is also tested in UNIX (Macintosh machine) using Netbeans as IDE, gfortran as 

Fortran compiler and inbuilt library (vecLib) provided by Apple Inc.  

3 Deploying Source Code 

This section describes the method of deploying the source code and compiling it 

with required library files. The program is compiled and tested in both Windows and 

UNIX platform. Here, deploying in Windows platform is explained in detail. 
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Many Integrated Development Environments (IDEs) are available in Microsoft 

Windows platform for example Netbeans, MS Visual Studio and FORTRAN compilers 

like gfortran and Intel Visual Fortran etc. Deploying the source code using Microsoft 

Visual Studio 2008 along with Intel Composer XE 2011 Fortran compiler which 

includes Intel Math Kernel Library (MKL) is described below. 

Create a new project from menu File > New > Project. The window shown in 

Fig. 23 will be opened. Click on Intel® Visual Fortran from left menu and select Empty 

Project from Templates. Name the project “MDLHydroD” and select a location as 

shown in Fig. 23. Click OK to save the project.  

 

 

Fig. 23. New project window 
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Open the directory where the project is saved and go inside MDLHydroD 

directory. Create a new directory called “Source” and save all source files here as shown 

in Fig. 24.  

 

 

Fig. 24. Source directory 

 

Now from menu Project>Add Existing Item select all the source files and add 

them to the project. The source files will be displayed under Source Files in Solution 

Explorer view as shown in Fig. 25.  
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Fig. 25. Solution Explorer 

 

Now to setup the compiler options and libraries, open project properties from 

menu Project>MDLHydroD Properties. Then click on Configuration 

Properties>Fortran>General in the left menu. In Additional Include Libraries add the 

location of Intel Math Kernel Libraries (MKL). The path looks like “C:\Program Files 

(x86)\Intel\Composer XE 2011 SP1\mkl\include”  
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Fig. 26. Configuration Properties - Fortran – General 

 

 

Next under Fortran>Preprocessor, select Preprocess Source Files – Yes, and 

add the same “include” directory location if not added automatically. 

 

 

 

Fig. 27. Configuration Properties - Fortran - Processor 
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Next open “Configuration Properties>Linker>General” and add the MKL library 

location (“C:\Program Files (x86)\Intel\Composer XE 2011 SP1\mkl\lib\ia32”) in 

Additional Library Directories.  

 

 

Fig. 28. Configuration Properties - Linker – General 

 

 

 

Then open Linker>Input and in the Additional Dependencies add following 

libraries: “mkl_intel_c.lib mkl_intel_thread.lib mkl_core.lib libiomp5md.lib”. Click OK 

to save setting and close the properties window. 
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Fig. 29. Configuration Properties - Linker – Input 

 

 

Once done, click on menu option Build>Build Solution to compile the source 

files. Now click on Debug>Start Debugging to test the program.  

 

 

Fig. 30. Running MDLHydroD 
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APPENDIX II  

RUNNING MDLHYDROD 

 

The program MDL HydroD is developed using FORTRAN and the source is 

compiled in both UNIX and WINDOWS machine. The executable file and the input files 

needs to be placed under the same directory. The WINDOWS user needs to open a 

command prompt (   Start All Programs Accessories Command Prompt    ) and use 

cd  command to enter the directory where the executable and input files are saved. Then 

type mdlhydrod.exe and press enter to execute the program.  

1 Input Files 

Two input files are required, one specifying the geometry of the body to be 

analyzed and another specifying configurations such as frequency, wave heading angle, 

radius of gyration, location of body coordinate system origin etc. These two files 

structure is explained in detail below. 

2 The Geometric Data File 

The wave load is calculated for submerged part of the body under mean 

waterline. The Geometric Data File (*.GDF) is a standard body geometry description file 

which is similar to format used by WAMIT and can be created easily from CAD 

software Rhinoceros. The GDF file contains a description of discretized surface, body 

length scale, gravity, symmetry indices, total number of panels specified, and for each 

panel the Cartesian coordinates , ,x y z  of its four vertices. A triangular panel can be 
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describes by defining two coincident vertices. A panel is described by four lines each 

containing 3 real numbers for , ,x y z  coordinate of the vertices separated by a space. The 

vertices must be arranged in anticlockwise fashion when looked from the fluid region. 

The coordinate system , ,x y z   in which the panels are defined is referred to as the body 

coordinate system. The body coordinate system must be a right-handed Cartesian system 

with z axis  vertical and positive upwards. 

The name of the GDF file can be any legal filename with maximum 100 

characters followed by ‘.gdf’ extension. 

The data in the GDF file can be input in the following form: 

Header 

ULEN UGRAV 

ISX ISY 

NSPAN 

X1(1) Y1(1) Z1(1) 

X2(1) Y2(1) Z2(1) 

X3(1) Y3(1) Z3(1) 

X4(1) Y4(1) Z4(1) 

X1(2) Y1(2) Z1(2) 

X2(2) Y2(2) Z2(2) 

X3(2) Y3(2) Z3(2) 

X4(2) Y4(2) Z4(2) 

… 

Input data must be in the order as shown above, with at least one blank space 

separating data on the same line. 

The definitions of each line in this file are as follows: 

 ‘Header’ denotes one line description of the file, must be less than 100 

characters. 
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ULEN is the dimensional length characterizing the body dimension. This 

quantity is used as length parameter L  for obtaining non-dimensional output. 

GRAV is the acceleration of gravity 2
9.80665 /m s . 

ISX, ISY are geometry symmetry indices. Currently MDL HydroD doesn’t 

support symmetry indices, hence only ISX=0, ISY=0 should be used. 

NPAN is equal to the number of panels with coordinates defined in this file.  

X1(1), Y1(1), Z1(1) are the ( , , )x y z of vertex 1of the first panel. X2(1), Y2(1), 

Z2(1) are the ( , , )x y z coordinate of second vertex of the first panel and so on. 

The origin of the body coordinate system is used to define the forces, moments 

and body motions.   

3 Configuration File 

The configuration file is used to define physical parameters, result parameters, 

geometry parameters, and solver parameters. This file can be created using any text 

editor (e.g. Notepad in Windows or Textedit in Macintosh). The file name must be same 

as the geometry definition file (*.GDF) with extension ‘*.cfg’. For example if the 

geometry file is named ‘Ship.gdf’ then the configuration file must be named ‘Ship.cfg’. 

The data in the CFG file can be input in following form:   

#Water density [kg/m^3] 

DENSITY 1025 

 

#Number of frequencies (NFRQ) and frequencies in Hz 

NFRQ -80 

0.01 0.01 

 

#Vertical Center of Gravity in body coordinate system 

VCG -61.7 
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#Location of Body Coordinate System 

XBODY 1 

0 0 0 0 

 

#Radiation of gyration 

XPRDCT 1 

70.54 0 0 

0 70.54 0 

0 0 61.85      

 

#beta (deg) 

NBETA 1 

0 

 

#SOLVER PARAMETERS 

#error 

ERROR 0.0000001 

 

#collocation point depth 

COLLDIST 0.0000001 

 

The data blocks can be written in any order and empty lines or comments can be 

entered anywhere. Any line starting with # is considered as a comment. The definition of  

each entry in this file are as follows: 

DENSITY is used to define water density in 3
/kg m . 

NFRQ denotes number of wave frequencies for which hydrodynamic analysis 

needs to be done. If NFRQ>0 the the frequencies must be defined in the next line 

separated by a space. If NFRQ<0 then the next line must be start of frequency and 

increment in frequency separated by space. The program will generate |NFRQ| 

frequency values starting from the defined value with defined increment. 

VCG is the dimensional z  coordinate of the center of gravityof the body relative 

to origin of the body coordinate system. 
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XBODY are the dimensional , ,x y z   coordinates of the origin of the body fixed 

coordinate system relative to the global coordinate system and the angle in degrees of 

the x axis  of the body coordinate system relative to the X axis  of the global 

coordinate system, defined as positive in the counterclockwise sense about the vertical 

axis. 

XPRDCT is the 3 3  matrix of the body radii of gyration about the body-fixed 

axes, where , 1, 2, 3I J   correspond to ( , , )x y z  respectively. These values are used to 

calculate the body inertia matrix 
ij

m  for , 4, 5, 6i j   according to the equation 

( 3, 3) ( 3, 3)
ij

m m XPRDCT i j XPRDCT i j        . The body mass m  is evaluated 

from the displaced mass of fluid. The remaining elements of 
ij

m  are evaluated assuming 

the body is freely floating in equilibrium, based on the calculated values of the displaced 

volume and center of buoyancy and on the specified value of VCG. In practical cases the 

matrix XPRDCT is symmetric. Zeros may be specified if the body motions are not 

evaluated. 

NBETA is the number of wave headings, must be an integer. 

BETA is an array of length NBETA defined as the wave headings in degrees. If 

NBETA is defined less than zero then the BETA should be defined as starting value and 

increment value. The array will be generated by the program with NBETA number of 

elements. 

ERROR is a solver parameter which is used to determine the accuracy 

requirement. Default value is 0.0000001 
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COLLDIST is the distance by which the source is pushed below the panel 

surface. Default value is 0.0000001. 

4 Output Files 

Once the program is executed it will create a new directory named “out” and 

store all output files inside this directory. The format of output files are described below. 

4.1 Hydrostatics 

The hydrostatics results are output in ‘*_hydrostatics.csv’ file. Following values 

are output: 

Table 9: Hydrostatics 

VOLX, VOLY,VOLZ 

Center of buoyancy relative to waterline 

Longitudinal center of buoyancy 

Water plane area 

Longitudinal center of floatation 

Water plane moment about x-axis 

Water plane moment about y-axis 

Hydrostatic stiffness terms (C33, C35, C44, C53,C55) 

 

4.2 Added Mass and Damping 

Non-dimensional added mass and damping are output in ‘*_AM_AD.csv’ file. 

Added mass and damping are non-dimensionalized as follows: 

 
ij

ij k

A
A

L
   (6.1) 

 
ij

ij k

B
B

L 
   (6.2) 

Here 
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k=3 for (i,j=1,2,3) 

k=4 for (i=1,2,3, j=4,5,6), or,(i=4,5,6,  j=1,2,3)

k=5 for (i,j=4,5,6)

  (6.3) 

The results are tabulated as: 

 

Table 10: Added mass and damping 

FRQ I J A(I,J) B(I,J) 

 

4.3 Radiation Pressure 

Radiation pressure at each panel center is exported in output file 

‘*_RadiationPressure.csv’ file. The results are tabulated as: 

 

 

Table 11: Radiation pressure 

FRQ Panel No Re(p1) Im(p1) Re(p2) Im(p2) … 

 

 

 

Here … denotes the remaining components for modes 3,4,5 and 6 

4.4 Pressure on Fixed Hull 

The diffraction pressure on the panels are exported in output file 

‘*_PressureOnFixdHull.csv’. The results are tabulated as: 

 

Table 12: Pressure on fixed hull 

FRQ BETA Panel No Mod(pD) Pha(pD) Re(pD) Im(pD) 
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4.5 Force 

Exciting forces are calculated using Haskind relation, direct pressure integration 

of hydrodynamic pressure and using Froude Krylov method. The forces are non-

dimensionalized as: 

 i

i m

X
X

gAL
   (6.4) 

where m =2  for i=1,2,3  and m =3 for i=4,5,6 . A  is the wave amplitude (1 in this case) 

and L  is the characteristic length parameter U LEN . 

Three separate output files are written named ‘*_ForceHaskind.csv’, 

‘*_ForceDiffractionPotential.csv’ and ‘*_ForceFroudeKrylov.csv’. Format used in 

exporting the result are as follows: 

 

Table 13: Force 

FRQ BETA Mode Mod(F) Pha(F) Re(F) Im(F) 

 

4.6 Response Amplitude Operator 

The response of the vessel due to waves of unit amplitude is output in the file 

‘*_RAO.csv’. Format of the output file is: 

 

Table 14: Response amplitude operator 

FRQ BETA I Mod(Xi) Pha(Xi) Re(Xi) Im(Xi) 
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4.7 Log File 

The program writes all runtime information and error messages in the ‘*.log’ file. 

The user should check this file for any errors during runtime before using the result 

output files. 

5 Post Processing 

The output files contain large number of data and it’s quite difficult to interpret 

the results from these files. MATLAB scripts are written to generate plots of the results 

obtained from MDL HydroD and also comparison plots with WAMIT output files. 

Following scripts are packaged under Matlab Post Processing directory: 

 plotAddedMassDamping.m 

 plotForce.m 

 getRAOdata.m 

 plotRAO.m 

 plotAddedMassDampingWAMIT.m 

 plotForceWAMIT.m 

 getRAOdataWAMIT.m 

 plotRAO_WAMIT.m 

 allplots.m 

The user needs to copy appropriate output files from MDL HydroD and WAMIT 

(if comparison is required) to the ‘Matlab Post Processing’ directory. Only the 

‘allplots.m’ file needs to be updated for different cases. Once this file is run, it will 
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generate plots and save them in a separate folder for each individual and WAMIT 

comparison cases. 
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APPENDIX III  

VERIFICATION AND VALIDATION 

 

The numerical implementation of the three dimensional method is verified for 

various test cases which include different floating and deeply submerged structures. The 

results obtained were compared with WAMIT (Wave Analysis Massachusetts Institute 

of Technology) version 7.03 results for identical setup. WAMIT is a well proven 

application most widely used across industry for hydrodynamic load prediction in the 

frequency domain and also based on the theory of three dimensional panel methods. 

The following quantities are compared for each structure: 

 Hydrostatics 

 Added Mass 

 Damping 

 Force calculated using Haskind relation 

 Force calculated using direct integration of diffraction pressure 

 Froude Krylov Force 

 Response Amplitude Operator 
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1 Floating Hemisphere 

1.1 Geometry and Panel Details 

 

Fig. 31. Floating hemisphere 

 

 

 

Table 15: Hemisphere dimension 

Parameter Value 

Radius 1 m 

Number of Panels 1152 

Water Depth Infinite 

Non dimensionalizing length (L)  1m 
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1.2 Hydrostatics 

Parameter MDLHydroD WAMIT 

Volume VOLX = 2.086208 

VOLY= 2.086209 

VOLZ = 2.086216 

VOLX = 2.08621 

VOLY= 2.08621 

VOLZ = 2.08621 

Center of Buoyancy Xb= 0.00000 

Yb= 0.00000 

Zb= -0.3744191 

Xb= 0.00000 

Yb= 0.00000 

Zb= -0.374416 

Hydrostatic Stiffness Terms C33 = 3.140320 

C35 =   4.2791362E-07 

C44 =   2.3961067E-03 

C55 =   2.3962855E-03 

C33 = 3.1403 

C35 =   4.2011E-07 

C44 =   2.4248E-03 

C55 =   2.4252E-03 

Water plane moment about 

x-axis  

  0.7835154 m
4
 --- 

Water plane moment about 

y-axis  

0.7835152 m
4
 --- 
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1.3 Added Mass and Damping 

 

 

 

Fig. 32. Floating hemisphere surge added mass A11 

 

Fig. 33. Floating hemisphere surge damping B11 
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Fig. 34. Floating hemisphere sway added mass A22 

 

 

 

Fig. 35. Floating hemisphere sway damping  B22 
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Fig. 36. Floating hemisphere heave added mass A33 

 

 

 

Fig. 37. Floating hemisphere heave damping B33 
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1.4 Forces 

 

 

Fig. 38. Floating hemisphere surge excitation force 

 

 

 

Fig. 39. Floating hemisphere heave excitation force 



 

101 

 

1.5 RAO 

 

 

Fig. 40. Surge RAO of floating hemisphere 

 

 

 

Fig. 41. Heave RAO of floating hemisphere  
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2 Floating cylinder 

2.1 Geometry and Panel Details 

 

 

Fig. 42. Floating cylinder 

 

 

Table 16: Cylinder dimension 

Parameter Value 

Radius 1 m 

Height 0.5 m 

Number of Panels 1024 

Water Depth Infinite 

Non dimensionalizing length (L) 1 m 
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2.2 Hydrostatics 

Parameter MDLHydroD WAMIT 

Volume VOLX = 1.568274 

VOLY= 1.568273 

VOLZ = 1.568273 

VOLX = 1.56827 

VOLY= 1.56827 

VOLZ = 1.56827 

Center of Buoyancy Xb= 0.00000 

Yb= 0.00000 

Zb= -0.2500000 

Xb= 0.00000 

Yb= 0.00000 

Zb= -0.250000 

Hydrostatic Stiffness Terms C33 = 3.136547 

C35 =   -1.2520468E-07 

C44 =   0.3881322   

C55 =   0.3881319 

C33 = 3.1365 

C35 =   1.6461E-07 

C44 =   0.38816 

C55 =   0.38816 

Water plane moment about 

x-axis  

  0.7802002 m
4
 --- 

Water plane moment about 

y-axis  

0.7802005 m
4
 --- 

 

2.3 Added Mass and Damping 

 

 

Fig. 43. Floating cylinder surge added mass A11 
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Fig. 44. Floating cylinder surge damping B11 

 

 

 

Fig. 45. Floating cylinder sway added mass A22 
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Fig. 46. Floating cylinder sway damping B22 

 

 

 

Fig. 47. Floating cylinder heave added mass A33 
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Fig. 48. Floating cylinder heave damping B33 

 

 

 

Fig. 49. Floating cylinder added mass A15 
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Fig. 50. Floating cylinder damping B15 

 

 

 

Fig. 51. Floating cylinder added mass A24 
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Fig. 52. Floating cylinder damping B15 

 

 

 

Fig. 53. Floating cylinder added mass A42 
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Fig. 54. Floating cylinder damping B42 

 

 

 

Fig. 55. Floating cylinder added mass A51 
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Fig. 56. Floating cylinder damping B51 

 

 

 

Fig. 57. Floating cylinder added mass A55 
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2.4 Forces 

 

Fig. 58. Floating cylinder surge excitation force 

 

 

 

Fig. 59. Floating cylinder heave excitation force 
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Fig. 60. Floating cylinder pitch excitation force 

 

 

2.5 RAO 

 

 

Fig. 61. Floating cylinder surge RAO 
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Fig. 62. Floating cylinder heave RAO 

 

 

 

Fig. 63. Floating cylinder pitch RAO 
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3 Box Barge 

3.1 Geometry and Panel Details 

 

 

Fig. 64. Box barge panel model 

 

 

Table 17: Box barge dimension 

Parameter Value 

Length 80 m 

Breadth 20 m 

Draft 10 m 

Number of Panels 1280 

Water Depth Infinite 

Non dimensionalizing length 40 m 
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3.2 Hydrostatics 

 

Parameter MDLHydroD WAMIT 

Volume VOLX = 16000.01 

VOLY= 15999.99 

VOLZ = 16000.00 

VOLX = 16000.0 

VOLY= 16000.0 

VOLZ = 16000.0 

Center of Buoyancy Xb= 0.00000 

Yb= 0.00000 

Zb= -5.000000 

Xb= 0.00000 

Yb= 0.00000 

Zb= -5.000000 

Hydrostatic Stiffness Terms C33 = 1.000000 

C35 =   3.7509952E-08 

C44 =    -2.9299891E-02 

C55 =  0.2827983 

C33 = 1.0000 

C35 =   -0.20827E-08 

C44 =   -2.9300E-02 

C55 =  0.28280 

Water plane moment about 

x-axis  

  851963.8 m
4
 --- 

Water plane moment about 

y-axis  

52992.30 m
4
 --- 

 

3.3 Added Mass and Damping 

 

 

Fig. 65. Box barge added mass A11 
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Fig. 66. Box barge damping B11 

 

 

 

Fig. 67. Box barge added mass A15 
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Fig. 68. Box barge damping B15 

 

 

 

Fig. 69. Box barge added mass A22 
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Fig. 70. Box barge damping B22 

 

 

 

Fig. 71. Box barge added mass A24 
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Fig. 72. Box barge damping B24 

 

 

 

Fig. 73. Box barge added mass A33 
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Fig. 74. Box barge damping B33 

 

 

 

Fig. 75. Box barge added mass A42 
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Fig. 76. Box barge damping B42 

 

 

 

Fig. 77. Box barge added mass A44 
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Fig. 78. Box barge damping B44 

 

 

 

Fig. 79. Box barge added mass A51 
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Fig. 80. Box barge damping B51 

 

 

 

Fig. 81. Box barge added mass A55 
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Fig. 82. Box barge damping B55 

 

 

 

Fig. 83. Box barge added mass A66 
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Fig. 84. Box barge damping B66 

 

3.4 Forces 

 

 

Fig. 85. Box barge surge excitation force 
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Fig. 86. Box barge heave excitation force 

 

 

 

Fig. 87. Box barge pitch excitation force 
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3.5 RAO 

 

Fig. 88. Box barge surge RAO 

 

 

 

Fig. 89. Box barge heave RAO 
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Fig. 90. Box barge pitch RAO 
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4 DWSC Spar 

The Deep Water Stable Craneship (DWSC) spar is a specialized hull to be used 

to transfer cargo from LMSR to T-Craft. 

4.1 Geometry and Panel Details 

 

 

Fig. 91. DWSC Spar panel model 

 

 

 

Table 18: Spar dimension 

Parameter Value 

Diameter (U) 6.0 m 

Diameter (L) 8.5 m 

Length 129.6 m 

Draft 118.0 m 

Number of Panels 1536 

Water Depth Infinite 

Non dimensionalizing length (L) 6.0 m 
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4.2 Hydrostatics 

 

Parameter MDLHydroD WAMIT 

Volume VOLX = 6353.422 

VOLY= 6353.422 

VOLZ = 6353.520 

VOLX = 6353.48 

VOLY= 6353.48 

VOLZ = 6353.46 

Center of Buoyancy Xb= 0.00000 

Yb= 0.00000 

Zb= -61.52966 

Xb= 0.00000 

Yb= 0.00000 

Zb= -61.529995 

Hydrostatic Stiffness Terms C33 = 0.7803620 

C35 =   -2.4283374E-08 

C44 =    0.8828591 

C55 =  0.8828591 

C33 = 0.78036 

C35 =   -0.12106E-07 

C44 =   0.88083 

C55 =  0.88083 

Water plane moment about 

x-axis  

  61.93528 m
4
 --- 

Water plane moment about 

y-axis  

61.93533 m
4
 --- 

 

4.3 Added Mass and Damping 

 

 

Fig. 92. Spar added mass A11 
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Fig. 93. Spar damping B11 

 

 

 

Fig. 94. Spar added mass A22 
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Fig. 95. Spar damping B22 

 

 

 

Fig. 96. Spar added mass A24 
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Fig. 97. Spar damping B24 

 

 

 

Fig. 98. Spar added mass A33 
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Fig. 99. Spar damping B33 

 

 

 

Fig. 100. Spar added mass A42 
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Fig. 101. Spar damping B42 

 

 

 

Fig. 102. Spar added mass A44 
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Fig. 103. Spar damping B44 

 

 

 

Fig. 104. Spar added mass A51 
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Fig. 105. Spar damping B51 

 

 

 

Fig. 106. Spar added mass A55 
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Fig. 107. Spar damping B55 

 

4.4 Forces 

 

Fig. 108. Spar surge excitation force 

 



 

139 

 

 

Fig. 109. Spar heave excitation force 

 

 

 

Fig. 110. Spar pitch excitation force 
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4.5 RAO 

 

Fig. 111. Spar surge RAO 

 

 

 

Fig. 112. Spar heave RAO 
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Fig. 113. Spar pitch RAO 
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5 USN LMSR Ship 

5.1 Geometry and Panel Details 

 

 

Fig. 114. USN LMSR Ship Bob Hope panel model 

 

 

 

Table 19: Ship dimension 

Parameter Value 

Length Between Perpendicular, Lpp 269.45 m 

Breadth molded on waterline, B 32.258m 

Draft, T 8.795 m 

Number of Panels 1416 

Water Depth Infinite 

Non dimensionalizing length 135 m 
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5.2 Hydrostatics 

 

Parameter MDLHydroD WAMIT 

Volume VOLX = 49017.17 

VOLY=  48950.77 

VOLZ = 49029.09 

VOLX = 49012.4 

VOLY= 48951.0 

VOLZ = 49033.7 

Center of Buoyancy Xb= -9.4776773 

Yb= 0.00000 

Zb= -3.897359 

Xb= -9.485846 

Yb= 0.00000 

Zb= -3.898955 

Hydrostatic Stiffness Terms C33 = 0.3918698 

C35 =   4.2208418E-02 

C44 =    6.0625182E-04 

C55 =  0.1000643 

C33 = 0.39187 

C35 =   4.2221E-02 

C44 =   6.0621E-04 

C55 =  0.10002 

 

5.3 Added Mass and Damping 

 

 

Fig. 115. Ship added mass A11 
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Fig. 116 Ship damping B11 

 

 

 

Fig. 117. Ship added mass A13 
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Fig. 118. Ship damping B13 

 

 

 

Fig. 119. Ship added mass A15 
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Fig. 120. Ship damping B15 

 

 

 

Fig. 121. Ship added mass A22 
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Fig. 122. Ship damping B22 

 

 

 

Fig. 123. Ship added mass A24 
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Fig. 124. Ship damping B24 

 

 

 

Fig. 125. Ship added mass A33 
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Fig. 126. Ship damping B33 

 

 

 

Fig. 127. Ship added mass A35 
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Fig. 128. Ship damping B35 

 

 

 

Fig. 129. Ship added mass A42 
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Fig. 130. Ship damping B42 

 

 

 

Fig. 131. Ship added mass A44 
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Fig. 132. Ship damping B44 

 

 

 

Fig. 133. Ship added mass A46 
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Fig. 134. Ship damping B46 

 

 

 

Fig. 135. Ship added mass A51 
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Fig. 136. Ship damping B51 

 

 

 

Fig. 137. Ship added mass A53 
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Fig. 138. Ship damping B53 

 

 

 

Fig. 139. Ship added mass A55 
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Fig. 140. Ship damping B55 

 

 

 

Fig. 141. Ship added mass A66 



 

157 

 

 

Fig. 142. Ship damping B66 

 

5.4 Forces 

 

 

Fig. 143. Ship surge excitation force 
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Fig. 144. Ship heave excitation force 

 

 

 

Fig. 145. Ship pitch excitation force 
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5.5 RAO 

 

Fig. 146. Ship surge RAO 

 

 

 

Fig. 147. Ship heave RAO 
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Fig. 148. Ship pitch RAO 
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6 T-Craft 

6.1 Geometry and Panel Details 

 

 

Fig. 149. T-Craft panel model 

 

 

 

Table 20: T-Craft dimension 

Parameter Value 

Length (On Cusion) 67.52 m 

Draft 1.33 m 

Cushion width 16.5m 

Number of Panels 914 

Water Depth Infinite 

Non dimensionalizing Length 1 m 
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6.2 Hydrostatics 

 

Parameter MDLHydroD WAMIT 

Volume VOLX = 350.4449 

VOLY=  350.4940 

VOLZ = 350.4655 

VOLX = 350.466 

VOLY= 350.469 

VOLZ = 350.470 

Center of Buoyancy Xb= -3.0188 

Yb= 0.00000 

Zb= -0.5564 

Xb= -3.023516 

Yb= -0.000003 

Zb= -0.556466 

Hydrostatic Stiffness Terms C33 = 358.6418     

C35 =   1024.897     

C44 =    33522.44     

C55 =   128026.5     

C33 = 358.64 

C35 =   1025.3 

C44 =   33522.0 

C55 =  0.12801E+06 

 

 

6.3 Added Mass and Damping 

 

 

Fig. 150. T-Craft added mass A11 



 

163 

 

 

Fig. 151. T-Craft damping B11 

 

 

 

Fig. 152. T-Craft added mass A22 
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Fig. 153. T-Craft damping B22 

 

 

 

Fig. 154. T-Craft added mass A33 
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Fig. 155. T-Craft damping B33 

 

 

 

Fig. 156. T-Craft added mass A44 
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Fig. 157. T-Craft damping B44 

 

 

 

Fig. 158. T-Craft added mass A53 
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Fig. 159. T-Craft damping B53 

 

 

 

Fig. 160. T-Craft added mass A55 
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Fig. 161. T-Craft damping B55 

 

 

 

Fig. 162. T-Craft added mass A64 
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Fig. 163. T-Craft damping B64 

 

 

 

Fig. 164. T-Craft added mass A66 
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Fig. 165. T-Craft damping B66 

 

6.4 Forces 

 

 

Fig. 166. T-Craft surge excitation force 
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Fig. 167. T-Craft heave excitation force 

 

 

 

Fig. 168. T-Craft pitch excitation force 
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6.5 RAO 

 

Fig. 169. T-Craft surge RAO 

 

 

 

Fig. 170. T-Craft heave RAO 
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Fig. 171. T-Craft pitch RAO 
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7 TLP 

7.1 Geometry and Panel Details 

 

 

Fig. 172. TLP panel model 

 

 

 

Table 21: TLP dimension 

Parameter Value 

Cylindrical Column Diameter 17 m 

Pontoon Lenght 69.12 m 

Number of Panels 4048 

Water Depth Infinite 

Non dimensionalizing Length 43.125 m 
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7.2 Hydrostatics 

 

Parameter MDLHydroD WAMIT 

Volume VOLX = 53066.41 

VOLY=  53066.43 

VOLZ = 53112.37 

VOLX = 53066.3 

VOLY= 53066.3 

VOLZ = 53112.3 

Center of Buoyancy Xb= 6.9180045E-05 

Yb= 0.00000 

Zb= -22.58567 

Xb= -0.000010 

Yb= -0.000007 

Zb= -22.605247 

Hydrostatic Stiffness Terms C33 = 0.4772040 

C35 =   -0.62022657E-07 

C44 =    8.8613532E-02 

C55 =  8.8613532E-02 

C33 = 0.47720 

C35 =   1.5344E-07 

C44 =   8.8593E-02 

C55 =  8.8592E-02 

 

7.3 Added Mass and Damping 

 

 

Fig. 173. TLP added mass A11 
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Fig. 174. TLP damping B11 

 

 

 

Fig. 175. TLP added mass A15 
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Fig. 176. TLP damping B15 

 

 

 

Fig. 177. TLP added mass A22 
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Fig. 178. TLP damping B22 

 

 

 

Fig. 179. TLP added mass A24 
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Fig. 180. TLP damping B24 

 

 

 

Fig. 181. TLP added mass A33 
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Fig. 182. TLP damping B33 

 

 

 

Fig. 183. TLP added mass A42 
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Fig. 184. TLP damping B42 

 

 

 

Fig. 185. TLP added mass A44 
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Fig. 186. TLP damping B44 

 

 

 

Fig. 187. TLP added mass A51 
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Fig. 188. TLP damping B51 

 

 

 

Fig. 189. TLP added mass A55 
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Fig. 190. TLP damping B55 

 

 

 

Fig. 191. TLP added mass A66 
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Fig. 192. TLP damping B66 

 

7.4 Forces 

 

 

Fig. 193. TLP surge excitation force 
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Fig. 194. TLP heave excitation force 

 

 

 

Fig. 195. TLP pitch excitation force 
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7.5 RAO 

 

Fig. 196. TLP surge RAO 

 

 

 

Fig. 197. TLP heave RAO 
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Fig. 198. TLP pitch RAO 
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